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Lời mở đầu 

 
           Ngày nay, thế giới đang chứng kiến sự thay đổi to lớn của nền sản 

xuất công  nghiệp do việc áp dụng những thành tựu của cuộc cách mạng  

khoa học công nghệ. Cùng với sự thay đổi của nền sản xuất công nghiệp, 

ngành khoa học công nghệ về tự động hoá cũng có những bước phát 

triển vượt bậc và trở thành ngành mũi nhọn của thế giới. 

 Khi mà tất cả mọi thứ đang dần trở nên tự động hóa, không còn cần quá 

nhiều vào công sức của con người thì việc học tập cũng như nghiên về tự 

động hóa sẽ giúp ích được rất nhiều cho đời sống nhân dân.  

 Từ những điều trên, nhận thấy trước tình hình khó khăn của nhân dân 

không chỉ riêng cả nước và cũng như toàn thế giới trước chủng virus vô 

cùng nguy hiểm mang tên Covid19. Nhằm mục đích sát khuẩn tay phục 

vụ mọi người để phòng tránh căn bệnh nguy hiểm của thế kỉ 20. Để 

phòng chống với chủng virus mới này, nhân dân đã phải tốn rất nhiều 

nhân lực, tiền của chỉ để phòng dịch. Với suy nghĩ thiết thực để giúp đỡ 

mọi người trong việc tự giác rửa tay sát khuẩn. Thay vì việc phải có 

người  xịt dung dịch thuốc sát khuẩn cho từng người thì bây giờ chỉ cần 

là giám sát người dân tuân thủ rửa tay. Từ đó đã thôi thúc sự tìm tòi, 

mong muốn đóng góp không chỉ của riêng em mà còn là sự dày công từ 

Tiến sĩ Ngô Quang Vĩ. 

 Dưới sự hướng dẫn của thầy giáo – TS Ngô Quang Vĩ cùng những kiến 

thức được học tập tại trường Đại học Quản lí và Công nghệ Hải Phòng. 

Em đã nhận và hoàn thành đề tài tốt nghiệp “ Thiết kế chế tạo máy rửa 

tay sát khuẩn tự động sử dụng chip Arduino”. 
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Đồ án gồm các nội dung sau: 

Chương I: Nghiên cứu tổng quan về các dạng máy sát khuẩn 

Chương II: Tìm hiểu cấu trúc vi điều khiển 

Chương III: Thiết kế, chế tạo máy sát khuẩn tự động có tích hợp giọng 

nói 

Kết luận 

Em xin chân thành cảm ơn sự hướng dẫn tận tình của 

Thầy giáo - TS. Ngô Quang Vĩ, cùng với các thầy cô giáo trong khoa đã 

giúp đỡ em hoàn thành đồ án này. 

Em mong nhận được sự đóng góp ý kiến của các thầy cô giáo và các bạn. 
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Chương 1.  

NGHIÊN CỨU TỔNG QUAN VỀ CÁC DẠNG 

MÁY SÁT KHUẨN 

 

1.1. Đại dịch COVID-19 là gì? Tại sao lại cần phải có sự quan tâm 

đặc biệt tới vậy? 

Đại dịch COVID-19 là một đại dịch bệnh truyền nhiễm với tác nhân là 

virus SARS-CoV-2, đang diễn ra trên phạm vi toàn cầu. Khởi nguồn vào 

cuối tháng 12 năm 2019 với tâm dịch đầu tiên được ghi nhận tại thành 

phố Vũ Hán thuộc miền Trung Trung Quốc, bắt nguồn từ một nhóm 

người mắc viêm phổi không rõ nguyên nhân. Giới chức y tế địa phương 

xác nhận rằng trước đó họ đã từng tiếp xúc, chủ yếu với những thương 

nhân buôn bán và làm việc tại chợ bán buôn hải sản Hoa Nam. Các nhà 

khoa học Trung Quốc đã tiến hành nghiên cứu và phân lập được một chủ 

coronavirus mới, được Tổ chứ Y tế Thế giới lúc đó tạm gọi là 2019-

nCov, có trình tự gen giống với SARS-CoV trước đây với mức tương 

đồng lên tới 79,5%. Các ca nghi nhiễm đầu tiên ở Vũ Hán được báo cáo 

vào ngày 31 tháng 12 năm 2019. Trường hợp tử vong do SARS-CoV-2 

đầu tiên xảy ra ở Vũ Hán vào ngày 9 tháng 1 năm 2020.  

 

 

 

 

 

 

 

 

 

 

 

 

Hình 1.1.1. Hình ảnh siêu vi thể hiện SARS-CoV-2. Các gai ở rìa ngoài 

của các hạt virus giống như một vương miện. 
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Hình 1.2.2. Hình ảnh kính hiển vi điện tử quét cho thấy SARS-CoV-2 

(màu vàng) nổi lên từ bề mặt tế bào (màu xanh/hồng) được nuôi cấy 

trong phòng thí nghiệm. 

https://vi.wikipedia.org/wiki/K%C3%ADnh_hi%E1%BB%83n_vi_%C4%91i%E1%BB%87n_t%E1%BB%AD_qu%C3%A9t
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Các ca nhiễm virus dầu tiên được xác nhận bên ngoài Trung Quốc bao 

gồm hai người phụ nữ ở Thái Lan và một người đàn ông Nhật Bản. Sự 

lây nhiễm virus từ người sang người đã được xác nhận cùng tỉ lệ bùng 

phát dịch tăng nhanh vào giữa tháng 1 năm 2020. Ngày 23 tháng 1 năm 

2020, chính phủ Trung Quốc quyết định phong tỏa Vũ Hán, toàn bộ hệ 

thống giao thông công cộng và hoạt động xuất- nhập khẩu đều bị tạm 

ngưng.  

Ngày 11 tháng 3 năm 2020, Tổ chức Y tế Thế giới ( WHO) ra tuyên bố 

“COVID-19” là “Đại dịch toàn cầu”.  

Sự lây truyền của Virus corona chủng mới chủ yếu lây lan qua các giọt 

bắn trong không khí khi một các nhân bị nhiễm bệnh ho hoặc hắt hơi 

trong phạm vi 3 foot(0,91m) đến 6 foot (1,8m). Trong số các trường hợp 

ban đầu, hai phần ba có tiền sử tiếp xúc với chợ buôn hải sản Hoa Nam. 

Tháng 5 năm 2020, một nghiên cứu tại Đại học HongKong cũng cho biết 

virus này cũng lây qua mắt cao gấp 100 lần so với SARS. 

  

Hình 1.1.3. Sự nhân lên của một hạt corona virus 
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Chính phủ các quốc gia trên thế giới đã tiến hành phản ứng đáp trả nhằm 

bảo vệ sức khỏe người dân cũng như các nhóm cộng đồng trên toàn cầu, 

bao gồm: hạn chế đi lại, phong tỏa kiểm dịch, ban bố tình trang khẩn 

cấp, sử dụng lệnh giới nghiêm, tiến hành cách ly xã hội, hủy bỏ các sự 

kiện đông người , đóng cửa trường học và những cơ sở dịch vụ, kinh 

doanh ít quan trọng, khuyến khích người dân tự nâng cao ý thức phòng 

bệnh, đeo khẩu trang, hạn chế ra ngoài khi không cần thiết, đồng thời 

chuyển đổi mô hình hoạt động kinh doanh, học tập, làm việc từ truyền 

thông sang trực tuyến. Một số ví dụ tiêu biểu có thể kể đến như: phong 

tỏa để kiểm dịch toàn bộ tại Ý và tỉnh Hồ Bắc của Trung Quốc ; các biện 

pháp giới nghiêm khác nhau ở Trung Quốc và Hàn Quốc ; phương pháp 

sàng lọc tại các sân bay và nhà ga ; hạn chế hoặc hủy bỏ các hoạt động 

du lịch tới những khu vực, vùng , quốc gia có nguy cơ nhiễm dịch bệnh 

ở mức cao. Ngoài ra, các trường học cũng đã phải đóng cửa trên toàn 

quốc hoặc ở một số vùng tại hơn 160 quốc gia, ảnh hưởng đến 87% học 

sinh, sinh viên trên toàn thế giới, tính đến ngày 28 tháng 3 năm 2020. 

Theo thống kê tính đến ngày 27 tháng 9 năm 2020, số ca tử vong trên 

toàn cầu do hoặc có liên quan tới COVID-19 đã hơn 1 triêu người. Đó 

chính là lí do tại sao chúng ta cần phải phòng, chống “Đại dịch thế kỉ” 

mang tên COVID-19 

 

  

Hình 1.1.4. Biểu đồ số ca tử vong do COVID-19 

đến thời điểm hiện tại 
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Các cách để phòng ngừa dịch bệnh:  

Rửa tay 

Rửa tay được đề xuất để ngăn ngừa sự lây lan của bệnh. CDC Hoa 

Kỳ khuyên mọi người nên rửa tay thường xuyên bằng xà phòng và nước 

trong ít nhất 20 giây, đặc biệt là sau khi đi vệ sinh hoặc khi tay bị bẩn; 

trruowcs khi ăn và sau khi xì mũi, ho hoặc hắt hơi. Họ khuyến nghị sử 

dụng thêm dung dịch rửa tay khô với ít nhất 60% cồn khi không có sẵn 

xà phòng và ngước. WHO cũng khuyên mọi người tránh chạm vào mắt, 

mũi hoặc miệng nếu tay dơ. 

Vệ sinh đường hô hấp. 

Các tổ chức y tế khuyến cáo mọi người nên che miệng và mũi bằng 

khăn giấy khi ho hoặc hắt hơi . Không có bằng chứng cho thấy việc đeo 

khẩu trang của những người không bị nhiễm bệnh có nguy cơ thấp là có 

hiệu quả và Tổ chức Y tế Quốc tế không khuyến nghị sử dụng khẩu 

trang cho người khỏe mạnh. Việc sử dụng khẩu trang y tế của những 

người có thể bị nhiễm bệnh đã được khuyến nghị, vì chúng ta có thể giới 

hạn thể thích và khoảng cách di chuyển của các giọt thở phân tán khi nói 

chuyện, hắt hơi và ho. WHO đã ban hành hướng dẫn về thời điểm và 

cách sử dụng khẩu trang, bao gồm: 

- Che miệng và mũi bằng khẩu trang và đảm bảo không có khoảng 

trống giữa mặt và khẩu trang. 

- Tránh chạm vào khẩu trang trong khi sửa dụng nó; nếu bạn làm 

thế,hãy làm sạch tay bằng dung dịch rửa tay hoặc xà phòng và 

nước. 

- Thay khẩu trang mới ngay khi bị ẩm và không sử dụng lại khẩu 

trang sử dụng một lần. 

- Tháo khẩu trang bằng cách cầm dây đeo từ phía sau; vứt bỏ ngay 

lập thức và làm sạch tay. 

Tự cách ly, cách ly với cộng đồng cũng là một cách để giảm thiếu 

tối đa nguy cơ bị lây nhiễm. 

Từ thực trạng bệnh dịch trên, đã có rất nhiều người không chỉ là các 

bác sĩ, giáo sư tiến sĩ về y học nghiên cứu, tìm hiểu cách để phòng chống 

bệnh nguy hiểm này, mà còn có rất nhiều người, nhiều ngành nghề bắt 

tay vào để nghiên cứu ra cách tốt nhất để đóng góp cho nhân loại những 

phương tiện, cách thức phòng chống dịch hiểu quả nhất. Với mục đích 

tránh tối đa số người tập trung, phòng dịch hiệu quả thì các thiết bị như : 

máy xịt tự động, máy đo thân nhiệt tự động đã ra đời..... 
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1.2 Nghiên cứu tổng quan về các dạng máy sát khuẩn 

1.2.1 Tác dụng của máy rửa tay sát khuẩn tự động. 

Hiện nay, trên thị trường có rất nhiều loại máy xịt sát khuẩn tay tự 

động được phát minh và ra đời dựa trên nguyên lí hoạt động của cảm 

biến không tiếp xúc. Với sự phát triển của ngành công nghiệp, cuộc sống 

của con người ngày càng trở nên tiện lợi, nhàn hạ hơn. Với những chiếc 

máy xịt sát khuẩn này sẽ thay thế được rất rất nhiều công việc như : tự 

dùng tay để lấy dung dịch sát khuẩn, hoặc không thì có người đứng xịt 

cho mình, không còn phải lo về việc tiết kiệm dung dịch sát khuẩn … v.v 

… 

Từ đó, trong tình hình dịch bệnh Covid19 đang trở nên ngày càng 

nghiêm trọng, thì những chiếc máy này đã và đang giúp cho con người 

giảm tải được số lượng công việc để có được một kết quả phòng dịch 

hiệu quả nhất. Với những chiếc máy có thông số như: 

1.Relay thời gian. 

2.Relay trung gian  

3.Bơm 12V 

4.Nguồn 12V 

       5. Cảm biến quang nhận tín hiêu vật cản. 

Chỉ đơn giản như vậy đã có thể tạo ra một chiếc máy sát khuẩn tay 

tự động.  
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Với chức năng:  

Người dùng đưa tay vào, cảm biến nhận diện và tự động phun xịt ra 

một lượng dung dịch khử khuẩn vừa đủ để có thể dùng pin với thời 

lượng 10.000 lần xịt. 

Thích hợp với tất cả loại dung dịch rửa tay kháng khuẩn. 

Những chiếc máy như vậy ra đời nhằm mục đích nâng cao đời sống 

con người, giảm tải số lượng công việc trong những ngày đại dịch này để 

không có thêm những ca nhiễm bệnh mới.  

 

 

 

 

 Hình 1.2.1.1. Sơ đồ máy xịt sát khuẩn tay tự 

động 
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CHƯƠNG 2. 

TÌM HIỂU CẤU TRÚC VI ĐIỀU KHIỂN 

2.1. Chip Arduino. 

2.1.1 Chip Arduino là gì. 

Arduino một nền tảng mã nguồn mở phần cứng và phần mềm. 

Phần cứng Arduino (các board mạch vi xử lý) được sinh ra tại thị trấn 

Ivrea ở Ý, nhằm xây dựng các ứng dụng tương tác với nhau hoặc với 

môi trường được thuận lợi hơn. Phần cứng bao gồm một board mạch 

nguồn mở được thiết kế trên nền tảng vi xử lý AVR Atmel 8bit, hoặc 

ARM Atmel 32-bit. Những Model hiện tại được trang bị gồm 1 cổng 

giao tiếp USB, 6 chân đầu vào analog, 14 chân I/O kỹ thuật số tương 

thích với nhiều board mở rộng khác nhau. 

Được giới thiệu vào năm 2005, Những nhà thiết kế của Arduino 

cố gắng mang đến một phương thức dễ dàng, không tốn kém cho những 

người yêu thích, sinh viên và giới chuyên nghiệp để tạo ra những thiết bị 

có khả năng tương tác với môi trường thông qua các cảm biến và các cơ 

cấu chấp hành. Những ví dụ phổ biến cho những người yêu thích mới bắt 

đầu bao gồm các robot đơn giản, điều khiển nhiệt độ và phát hiện chuyển 

động. Đi cùng với nó là một môi trường phát triển tích hợp (IDE) chạy 

trên các máy tính cá nhân thông thường và cho phép người dùng viết các 

chương trình cho Aduino bằng ngôn ngữ C hoặc C++. 
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2.1.2 Phần nguồn của Board mạch Arduino được thiết kế để thực 

hiện các nhiệm vụ: 

 

 
 

  Hình 2.1.2.1 Board mạch Arduino 
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- Lựa chọn nguồn cung cấp cho board mạch ( Khối màu cam trong 

hình). Board mạch Arduino có thể được cung cấp nguồn bởi Adapter 

thông qua Jack DC hoặc từ cổng USB (2 mũi tên màu đỏ). Trong trường 

hợp chỉ có 1 trong 2 nguồn cung cấp thì Board Arduino sẽ sử dụng 

nguồn cung cấp đó. Trong cáp từ Jack DC thay vì từ cổng USB. Việc ưu 

tiên này sẽ được thực hiện bởi OpAmp trong IC LMV358 và MOSFET 

FDN340P. điện áp từ Jack DC sau khi qua Diode bảo vệ D1 thì được gọi 

là điện áp VIN. Điện áp VIN qua cầu điện áp đầu ra của OpAmp là 5V, 

điều này làm cho MOSFET không được kích, nguồn cung cấp cho Board 

Arduino là từ Jack DC sau khi qua ổn áp. 

- Tạo ra các điện áp 5v và 3.3v (2 khối màu xanh) để cung cấp cho 

vi điều khiển và cũng là điểm cấp nguồn cho các thiết bị bên ngoài sử 

dụng. mạch Arduino sử dụng IC ổn áp NCP1117 để tạo điện áp 5v từ 

nguồn cung cấp lớn và IC ổn sáp LP 2985 để tạo điện áp 3.3V. Đây đều 

là những IC ổn áp tuyến tính, tuy hiệu suất không cao nhưng ít gợn nhiễu 

và mạch đơn giản. 

- Bảo về ngược nguồn, quá tải ( Vòng tròn màu đỏ). F1 là một cầu 

chì tự phục hồi, trong trường hợp bạn chỉ sử dụng dây cáp USB để cấp 

nguồn thì tổng dòng tiêu thụ không được quá 500mA. Nếu không cầu chì 

sẽ ngăn không cho dòng điện chạy qua. D1 là một Diode, chỉ cho dòng 

điện 1 chiều chạy qua (từ Jack DC vào mạch), trong trường hợp mạch 

Arduino của bạn có mắc với các thiết bị khác và có nguồn cung cấp lớn 

hơn nguồn vào Jack DC, nếu có sai sót chập mạch..v.v.. thì sẽ không có 

trường hợp nguồn các thiết bị bên ngoài chạy ngược vào Adapter. 

- Báo nguồn. Đèn nguồn ON sáng lên báo thiết bị đã được cấp 

nguồn. nếu các bạn đã cắm nguồn mà đèn nguồn không sáng thì có thể 

nguồn cung cấp của bạn đã bị hỏng hoạc Jack kết nối lỏng, hoặc mạch 

Arduino kết nói với các linh kiện bên ngoài bị ngắn mạch 
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2.1.3. Thiết kế mạch dao động. 

Mạch giao động tạo ra các xung clock giúp cho vi điều khiển hoạt 

động, thực thi lệnh. Board mạch Arduino Uno R3 sử dụng thạch anh 

16Mhz làm nguồn dao động.  

 

 

2.1.4 Thiết kế mạch reset. 

Để vi điều khiển thực hiện khởi động lại thì chân RESET phải ở 

mức logic LOW(~0V) trong 1 khoảng thời gian đủ yêu cầu. Mạch reset 

của Board Arduino phải đảm bảo được 2 việc: 

Reset bằng tay: khi nhấn nút , chân RESET nối với GND, làm cho 

MCU RESET. Khi không nhấn nút chân Reset được kéo 5V. 

- Reset tự động: Reset tự động được thực hiện ngay khi cấp nguồn 

cho vi điều khiển nhờ sự phối hợp giữa điện trở nối lên nguồn và tụ điện 

nối đất. Thời gian tụ điện nạp giúp cho chân RESET ở mức LOW trong 

1 khoảng thời gian đủ để vi điều khiển thực hiện reset. 

- Khởi động vi điều khiển trước khi nạp chương trình mới. 

Hình 2.1.3.1 
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2.1.5 Thiết kế mạch nạp và giao tiếp máy tính. 

- Vi điều khiển Atmega328P trên Board Arduino Unor3 đã được 

nạp sẵn 1 bootloader, cho phép nhận chương trình mới thông qua chuẩn 

giao tiếp UART( chân 0 và 1) ở những giây đầu sau khi vi điều khiển 

reset. 

- Máy tính giao tiếp với Board mạch Arduino qua chuẩn giao tiếp 

USB(D+/D-), thông qua một vi điều khiển trung gian là ATMEGA16U2 

hoặc một IC trung gian là CH340( thường tháy trong các mạch sử dụng 

chip dán). Vi điều khiển hoặc IC này có nhiệm vụ chuyển đổi chuẩn giao 

tiếp USB thành chuẩn giao thiếp UART để nạp chương trình hoạc giao 

tiếp truyền nhận dữ liệu với máy tính (Serial). 

Hình 2.1.4.1 
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- Phần thiết kế mạch nạp có tích hợp thêm 02 đèn LED, nên khi 

nạp chương trình các bạn sẽ thấy 2LED này nhấp nháy. Còn khi giao 

tiếp, nếu có dữ liệu từ mấy tính gửi xuoossng vi điều khiển thì đèn LED 

Rx sẽ nháy. Còn nếu có dữ liệu từ vi điều khiển gửi lên máy tính thì đèn 

Tx sẽ nháy. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2. Mạch role. 

2.2.1 Rơle là gì? 

Rơ le được sử dụng để truyền điện năng đến nhiều đèn tín hiệu rẽ 

trên xe và khiên những đèn đó bật hoặc tắt để cảnh báo cho những người 

lái xe khác. Nó cung cấp kết nối điện giữa hay hoặc nhiều điểm , khi áp 

dụng tín hiệu điều khiển với cuộn điện từ của rơ le. 

Rơ le chuyển trường từ của cuộn dây thành lực cơ học để mở hoặc 

đóng cơ khí một hoặc nhiều tiếp điểm điện. 

Hình2.1.5.1 Mạch nạp và giao tiếp chip Arduino 
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Nói theo cách khác, rơ le là một công tắc vận hành bằng điện. 

Điện áp và dòng điện được rơ le chuyển mạch có thể rất khác so 

với tín hiệu được sử dụng để kích hooạt hoặc cấp điện cho rơ le, là 

những chức năng vô cùng hữu ích trong tự động hóa nhà máy. 

Rơ le thông dung, với rất nhiều dạng, là một thiết bị độc lập có giá 

thành nói chung thấp, thực hiện nhiều chức năng hữu ích trong cuộc 

sống hằng ngày của chúng ta cũng như trong nhà máy. 

2.2.2 Chức năng điều khiển của Rơ le trong nhà máy 

Trong thế giới Tự động hóa của nhà máy, các thiết bị điều khiển 

công nghiệp như PLC, bộ hẹn giờ , bộ đếm và thiết bị kiểm soát nhiệt độ 

vận hành ở điện áp và dòng điện tương đối thấp. Thông thường nhỏ hơn 

25V. Tuy nhiên, khi tín hiệu đầu ra của các thiết bị trong nhà máy, 

thường cần mức điện lớn hơn. Khi một thiết bị điều khiển xuất ra lệnh 

24V để bật động cơ 220VAC, thông tin điện áp thấp này được chuyển 

tiếp đến một thiết bị có khả năng chuyển mạch điện lớn hơn này theo 

lệnh. 

Rơ le điện cơ có thể thực hiện chức năng này. 
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Hình 2.2.2.1 Hình minh họa chức năng của Relay 
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2.2.3 Ứng dụng của rơ le 

Rơ le điện thực hiện rất nhiều chức năng. Một số chức năng bao gồm: 

- Cách ly các mạch điều khiển khỏi mạch tải hoặc mạch điện được 

cấp điện AC khỏi mạch điê được cấp điện DC. 

- chuyển mạch nhiều dòng điện hoặc điện áp sang các tải khác nhau 

sử dụng một tín hiệu điều khiển. 

 

- Giám sát các hệ thống an toàn công nghiệp và ngắt điện cho các 

máy  móc nếu đảm bảo độ an toàn. 

- Sử dụng một vài rơ le để cung cấp các chức năng logic đơn giản 

như ‘AND’, ‘NOT’,  hoặc ‘OR’ cho điều khiển tuần tự hoặc khóa 

liên động an toàn. 

2.2.4 Cấu trúc của rơ le điện. 

Dạng phổ biến nhất của rơ le điện gồm một cuộn dây điện được 

cuốn trên một lõi sắt từ. Bộ phận này có cả một phần tính được gọi là 

Ách từ(Yoke) và một phần động được gọi là phần ứng( Armature). Phần 

ứng được liên kết cơ học với một tiếp điểm động. 

Khi cuộn dây được cấp điện, từ trường được tạo ra xung quanh cuộn 

và được lõi tập trung lại Nam châm điện này hút phần ứng động để mở 

hoặc đóng trực tiếp các tiếp điểm điện. 

Khi rơ le bị ngắt điện từ trường biến mất và phần ứng, được lò xo phản 

hồi hỗ trợ, đưa tiếp điểm trở lại vị trí “bình thường” của nó/ 

Hình 2.2.3 .1 
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2.2.5 Các nguyên tắc vận hành 

Khi vận hành, có 5 bước cở bản xảy ra khi rơ le điện được cung cấp điện 

và bị ngắt điện: 

- Điện được cung cấp cho cuộn dây tạo ra từ trường.  

- từ trường điện được chuyển thành lực cơ học bằng cách hút phần 

ứng. 

- phần ứng đóng/mở một hoặc nhiều tiếp điểm. 

- Các tiếp điểm cho phép chuyển mạch điện sang tải như động cơ, 

bóng đèn, v.v 

- Sau khi điện áp cuộn bị loạn bỏ, từ trường biến mất, các tiếp điểm 

tách ra và trở về vị trí “bình thường” của chúng. 

- Các tiếp điểm có thể thường đóng hoặc thường mở. 

 

2.2.6 Cuộn dây rơ le.  

Thiết kế của cuộn dây rơ le quyết định thông số kỹ thuật đầu vào 

của rơ le. 

Rơ le được phân loại theo điện áp yêu cầu để cấp điện cho cuộn dây 

của chúng. Nếu không đủ điện, từ trường của cuộn dây sẽ quá yếu để di 

chuyển tiếp điểm. Nếu quá điện đầu vào, cuộn dây có thể bị hỏng. 

Hình 2.2.5.1 
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Một số rơ le yêu cầu dòng điện một chiều được cung cấp đúng cực 

và một số rơ le có thể sử dụng dòng điện xoay chiều hoặc dòng điện một 

chiều không phụ thuộc cực kết nối. 

 

- Rơ le A sẽ hoạt động với dòng điện một chiều hoặc dòng điện 

xoay chiều và không yêu cầu đi day đúng cực để rơ le hoạt động. 

- Rơ le B có một đi-ốt phát sáng để biểu thị khi cuộn dây được cấp 

điện. Đi-ốt phát sáng được phân cực, bởi vậy mặc dù cuộn dây rơ 

le không có gì đặc biệt, sự có mặt của đi-ốt phát sáng yêu cầu 

nguồn điện đúng cực để đi-ốt hoạt động 

  

Hình 2.2.6.1 
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2.3.Mạch Nguồn  

 

2.3.1 IC ổn áp là gì – Giới thiệu LM7805 

Là loại IC cung cấp điện áp ngõ vào với giá trị ổn định mặc dù trong 

lúc đó điện áp ngõ vào IC thay đổi liên tục và thiếu sự ổn định. IC 7805 

là một trong rất nhiều loại IC ổn áp khác nhưng khả năng ổn áp của nó 

thì không thể xem thường. IC 7805 được phân loại là một loại IC điều 

chế điện áp DC dương vì ngõ ra của IC này luôn có mức điện áp dương 

so với mức điện áp nối mát (GND). 7805 được thiết kế bao gồm 3 chân. 

Chân thứ nhất là để điện áp DC đầu vào, chân thứ 2 là để đấu với mát  

(chân GND), chân thứ 3 là chân ngõ điện áp ổn áp, điện áp ngõ ra là 5V 

(với điều kiện là điện áp đầu vào lớn hơ 5V). Điện áp hoạt động của IC 

nen ở khoảng A để IC hoạt động được lâu dài. 

  
Hình 2.3.1.1 
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2.3.2 Thiết kế mạch ổn áp 5V dung 7805: 

 

 

- Chúng ta sẽ cấp điện áp đầu vào qua J2 ( tương ứng theo các chân 

âm dương) và điện áp 5V ở ngõ ra sẽ được lấy qua chân J1. 

- Tụ C1 và C2 để lọc điện áp đầu vào cấp cho chân Vi của IC 7805, 

tụ C1 có tác dụng cung cấp điện áp tạm thời cho chân Vi khi 

nguồn đột ngột bị sụt áp, tụ C2 là tụ gốm nên trở kháng lớn hơn, 

C2 có tác dụng ngăn nguồn đầu vào tăng áp đột ngột làm dạng 

song điện áp đầu vào có hình rang cưa. 

- Tụ C3 và C4 để lọc điện áp cấp cho tải tiêu thụ lấy từ chân Vo của 

IC 7805, tụ C3 có tác dụng cung cấp điện áp tạm thời cho tải khi 

điện áp tải đột ngột bị sụt áp, tụ C4 trở kháng lớn, C4 có tác dụng 

lọc nhiễu điện áp đầu ra ( nhiễu là các điện áp không mong muốn 

làm cho dạng song điện áp ngõ ra có hình rang cưa). 

 

  

Hình 2.3.2.1 



 

 

 24 

2.4 Cảm biến hồng ngoại 

2.4.1 Cảm biến hồng ngoại là gì? 

Cảm biến hồng ngoại hay còn được gọi là IR Sensor, chúng là một 

thiết bị điện tử có khả năng đo và phát hiện bức xạ hồng ngoại trong môi 

trường xung quanh. Cảm biến hồng ngoại (IR Sensor) phát ra các tia vô 

hình đối với mắt người, vì bước song của nó dài hơn ánh sáng khả kiến 

(mặc dù nó vẫn nằm cùng một phổ điện từ). Bất cứ thứ gì phát ra nhiệt 

(mọi thứ có nhiejt đọ trên 5 độ kevil) đều phát ra bức xạ hồng ngoại. 

Hồng ngoại hay còn gọi là tia hồng ngoại là bức xạ điện từ có bước 

song dài hơn ánh sáng và ngắn hơn tia bức xạ Vi ba. Hồng ngoại tức là 

ngoài bức sóng đỏ. Màu đỏ là màu có bước sóng dài nhất trong ánh sáng 

thường. Thông thường những vật thể có nhiệt độ trên 35
o 

C sẽ phát ra 

bước sóng hồng ngoại. Bức xạ hồng ngoại đã vô tình được phát hiện bởi 

một nhà thiên văn học tên là William Herschel vào năm 1800. Trong khi 

đo nhiệt độ của từng màu ánh sáng ( cách nhau bởi một lăng kính), ông 

nhận thấy rằng nhiệt độ vượt ra ngooài ánh sáng đỏ là cao nhất. 

 

  
Hình 2.4.1.1 Cảm biến hồng ngoại thụ động 
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Có hai loại cảm biến hồng ngoại đó là cảm biến dạng chủ động và 

thụ động. Cảm biến hồng ngoại hoạt động bằng cách phát ra và phát hiện 

bức xạ hồng ngoại. Cảm biến hồng ngoại chủ động thường cấu tạo có hai 

phần: Diode phát sáng (LED) và máy thu. Khi một vật thể đến gần cảm 

biến, ánh sáng hồng ngoại từ đèn LED sẽ phản xạ khỏi vật thể được 

người nhận phát hiện. Cảm biến hồng ngoại hoạt động đóng vai trò là 

cảm biến tiệm cận và chúng thường được sử dụng trong các hệ thống 

phát hiện chướng ngại vật (như trong robot) 

Hồng ngoại thụ động có nghĩa là chỉ nhận các tia hồng ngoại phát ra 

từ vật thể khác như người, động vật hoặc nguồn nhiệt bất kỳ, chứ tự nó k 

phát ra tia hồng ngoại nào cả. Sau khi nhận biết được nguồn nhiệt, bộ 

phận cảm biến sẽ phân tích đẻ xác định điều kiện báo động. Vì thế người 

ta gọi đó là thụ động, chỉ phát hiện chứ không phải là nguồn phát ra hồng 

ngoại. 

 

  Hình 2.4.1.2.Mô tả hoạt động của một cảm biến hồng ngoại 
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2.4.2 Nguyên tắc hoạt động của cảm biến hồng ngoại. 

Cảm biến hồng ngoại sẽ hooạt động bằng cách sử dụng một cảm 

biến ánh sáng cụ thể để phát hiện bước sóng ánh sáng chọn trong phổ 

hồng ngoại( IR). Bằng cách sử dụng đèn LED tạo ra ánh sáng có cùng 

bước sóng với cảm biến đang tìm kiếm, có thể xem cường độ của ánh 

sáng nhận được. Khi một vật ở gần cảm biến, ánh sáng từ đén LED bật 

ra khỏi vật thể và đi vào cảm biến ánh sáng. Điều này dẫn đến một bước 

nhảy lớn về cường độ và có thể phát hiện bằng cách sử dụng một 

ngưỡng. 

2.4.3 Sơ đồ mạch thiết kế cảm biến hồng ngoại. 

Vì cảm biến hồng ngoại sử dụng cảm biến ánh sáng, nên sơ đồ rất 

giống với cảm biến ánh sáng. Sự khác biệt duy nhất là việc bổ sng đèn 

LED hồng ngoại và đầu dò hồng ngoại yêu cầu kết nối với 5V và nối đất. 

Dưới đây là mạch tham khảo. 

 

 Hình 2.4.3.1 
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Cảm biến hồng ngoại là thiết bị có nhiều tính năng nổi bật như: bật tắt 

đèn tự động, báo trộm, mở cửa tự động... 

- Cảm biến hồng ngoại giúp bật tắt đèn tự động: với chức năng bật 

đèn tự động khi có người bước vào thì cảm biến hồng ngoại tự động đèn 

sẽ sáng lên. Và khi người di chuyển đến đâu thì đèn sáng đến đó. Vì thế 

mà ở các không gian lắp đặt thiết bị cảm biến hồng ngoại ở những vị trí 

như hành lang dùng bật đèn chiếu sáng lối đi hoặc nhà vệ sinh sẽ giúp 

cho các không gian đó được chiếu sáng luôn. 

- Cảm biến hồng ngoại giúp chống trộm: so với các thiết bị chống 

trộm khác thì việc sử dụng thiết bị cảm biến hồng ngoại giúp chống trộ 

tốt nhất, bảo vệ được gia đình. 

2.4.4 Những lưu ý không thể bỏ qua khi lắp đặt và sử dụng cảm 

biến hồng ngoại 

      Khi lắp đặt cần chú ý những vấn đề sau: 

      Không hướng mắt sensor về phía dàn nóng máy lạnh. Vì dàn nóng 

máy lạnh khi hoạt động thường có nhiệt độ cao, tia bức xạ hồng ngoại 

của nó phát ra sẽ gây nhiễu cảm biến, khiến nó hoạt động không chính 

xác. 

       Không hướng mắt sensor về phía cửa sổ có rèm che. Theo tôi, lý do 

của việc này là để tránh báo động giả. Khi cửa sổ mở, nhiều nguồn nhiệt 

xâm nhập, rèm che gặp gió sẽ có thể gây nhiễu cảm biến vi sóng. 

        Không lắp đặt cảm biến PIR trong nhà ra ngoài trời. Cảm biến PIR 

loại trong nhà không có tính năng chịu mưa nắng, để ngoài trời dù không 

trực tiếp gặp mưa nắng, nó cũng dễ bị hỏng dần chất liệu vỏ, lăng kính 

fresnel, khiến chức năng hoạt động kém dần đi. 

        Không hướng trực tiếp mắt sensor về nơi nhiều nắng mặt trời. Tia 

mặt trời có nhiều bức xạ hồng ngoại, khiến sensor bị nhiễu. 
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 Không nên đặt sensor gần dây điện nguồn. Cảm biến PIR là một thiết 

bị điện tử, hoạt động ở điện áp thấp nên hạn chế đặt gần điện nguồn cao 

áp. 

        Không nên hướng mắt sensor ra phía cổng sát đường đi. Lý do đơn 

giản là để tránh báo động giả không đáng có do người khác đi bộ hoặc 

chạy bộ ngang qua cổng. Sensor có thể lầm với việc đột nhập. 

        Không lắp sensor trên tường bị rung. Điều này giúp sensor hoạt 

động ổn định hơn 

Khi sử dụng cần chú ý: 

        Để sử dụng đúng và có hiệu quả, cần có hiểu biết về nguyên lý hoạt 

động của các thiết bị cảm biến hồng ngoại. 

        Trước hết cần phải làm rõ ý nghĩa đầy đủ của chữ “hồng ngoại” của 

cảm biến. Thực ra phải gọi chính xác là “hồng ngoại thụ động” (Passive 

Infrared, thường viết tắt là PIR). Hồng ngoại chủ động (Active Infrared) 

là nói đến một vật thể bức xạ ra tia hồng ngoại. Cảm biến chúng ta 

thường dùng nhận tia hồng ngoại phát ra từ thân thể người (Hoặc nguồn 

nhiệt bất kỳ) chứ bản thân nó không tự phát ra tia hồng ngoại, sau đó 

phân tích để xác định điều kiện báo động. 

        Vậy nên nó là thụ động. 

  

 
Hình 2.4.4.1 
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Trong hướng dẫn lắp đặt của hầu hết mọi nhà sản xuất cảm biến PIR đều 

có ghi chú về các vị trí lắp cảm biến cần tránh. Nếu không để ý kỹ, 

người lắp đặt sẽ dễ phạm phải. Kết quả là cảm biến có khi không hoạt 

động đúng chức năng, có khi lại báo động giả. 

 Đặt đầu báo tại nơi kẻ đột nhập phải đi qua, hoặc tại nơi tạo ra một 

cái bẫy với kẻ gian. 

 Đặt đầu báo với độ cao đúng như tài liệu kỹ thuật chỉ dẫn. 

 Tính toán vùng cảm nhận của đầu báo sao cho phù hợp với vùng 

cần cảm nhận theo yêu cầu. 

 Tránh những vùng khuất (điểm mù) tại nơi lắp đặt, khiến đầu báo 

không thể phát hiện được chuyển động. 

 Kiểm tra khả năng cảm nhận của đầu báo sau khi lắp đặt. 

 Do đầu báo động hồng ngoại nhạy cảm với năng lượng hồng 

ngoại, cần lưu ý tránh các nguồn phát nhiệt, dễ gây ra báo động 

giả như: Gần cửa, điều hoà, lỗ thoát khí, bếp lửa và ánh sáng mặt 

trời. 

 Công nghệ giúp phân biệt vật nuôi    

2.5.Arduino IDE . 

2.5.1Arduino IDE là gì? 

Arduino IDE là một chương trình phần mềm mã nguồn mở cho phép 

người dùng viết và tải lên mã trong một môi trường làm việc thời gian 

thực. Vì mã này sau đó sẽ được lưu trữ trong đám mây, nó thường được 

sử dụng bởi những người đã tìm kiếm thêm một mức dư thừa. Hệ thống 

này hoàn toàn tương thích với bất kỳ bo mạch phần mềm Arduino nào. 

2.5.2 Chức năng và công dụng chính 

Arduino IDE có thể được triển khai trong các hệ điều hành 

Windows, Mac và Linux. Phần lớn các thành phần của nó được viết bằng 

JavaScript để chỉnh sửa và biên dịch dễ dàng. Mặc dù ý định chính của 

nó là dựa trên các mã viết, có một số tính năng đáng chú ý khác. Nó đã 

được trang bị một phương tiện để dễ dàng chia sẻ bất kỳ chi tiết nào với 

các bên liên quan dự án khác. Người dùng có thể sửa đổi bố trí nội bộ và 
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sơ đồ khi cần thiết. Có hướng dẫn trợ giúp chuyên sâu sẽ hữu ích trong 

quá trình cài đặt ban đầu. Các hướng dẫn cũng có sẵn cho những ai có 

thể không có nhiều kinh nghiệm với khung công tác Arduino. 

2.5.3 Cách sử dụng IDE 

Bước 1: Kết nối Arduino UNO R3 vào máy tính 

 

 

Bước 2: Tìm cổng kết nối của Arduino Uno R3 với máy tính 

Khi Arduino Uno R3 kết nối với máy tính, nó sẽ sử dụng một cổng COM 

(Communication port - cổng dữ liệu ảo) để máy tính và bo mạch có thể 

truyền tải dữ liệu qua lại thông qua cổng này. Windows có thể quản lí 

đến 256 cổng COM. Để tìm được cổng COM đang được sử dụng để máy 

tính và mạch Arduino UNO R3 giao tiếp với nhau, bạn phải mở chức 

năng Device Manager của Windows. 

Bạn mở cửa sổ Run và gõ lệnh mmc devmgmt.msc. 

Hình 2.5.3.1 

https://tdhteam.files.wordpress.com/2015/04/2015-04-10_15h42_30.png
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Sau đó bấm Enter, cửa sổ Device Manager sẽ hiện lên. 

Mở mục Ports (COM & LPT), bạn sẽ thấy cổng COM Arduino Uno R3 

đang kết nối

 

Hình 2.5.3.2 

Hình 2.5.3.3 

https://tdhteam.files.wordpress.com/2015/04/2015-04-10_16h37_56.png
https://tdhteam.files.wordpress.com/2015/04/2015-04-10_16h39_13.png
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Cổng kết nối ở đây là COM3. 

Thông thường, trong những lần kết nối tiếp theo, Windows sẽ sử 

dụng lại cổng COM3 để kết nối nên bạn không cần thực hiện thêm thao 

tác tìm cổng COM này nữa.

Hình 2.5.3.4 

http://k1.arduino.vn/img/2015/05/08/0/1384_123450-1431094167-0-4.png
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Bước 3: Khởi động Arduino IDE 

 

 

Bước 4: Cấu hình phiên làm việc cho Arduino IDE 

Vào menu Tools -> Board -> chọn Arduino Uno 

  

Hình 2.5.3.5 

Hình 2.5.3.6 

http://k2.arduino.vn/img/2015/05/08/0/1351_882450-1431094169-0-5.png
https://tdhteam.files.wordpress.com/2015/04/2015-04-10_16h41_51.png
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Vào menu Tools -> Serial Port -> chọn cổng Arduino đang kết nối với 

máy tính. Ở máy của mình là COM3. 

 

  Hình 2.5.3.7 

https://tdhteam.files.wordpress.com/2015/04/2015-04-10_16h43_56.png
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Xác nhận cổng COM của Arduino IDE ở góc dưới cùng bên phải cửa sổ 

làm việc 

 

Vào menu Tools -> Programmer -> chọn AVR ISP

 

Hình 2.5.3.8 

Hình 2.5.3.10 

http://k2.arduino.vn/img/2015/05/08/0/1352_882450-1431094176-0-8.png
http://k3.arduino.vn/img/2015/05/08/0/1331_812450-1431094179-0-9.png
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Bước 5: Mở và nạp mã nguồn chương trình mẫu 

Nạp một chương trình mẫu bằng cách vào menu File -> Examples -

> 01.Basics -> chọn Blink.  

 

  Hình 2.5.3.11 

https://tdhteam.files.wordpress.com/2015/04/2015-04-10_16h50_45.png
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Bạn sẽ thấy Arduino IDE mở một cửa sổ mới chứa mã nguồn Blink. Mã 

này có chức năng là điều khiển đèn LED màu cam trên mạch Arduino 

Uno R3 nhấp nháy với chu kì 1 giây. 

 

  Hình 2.5.3.12 

http://k2.arduino.vn/img/2015/05/08/0/1353_882450-1431094185-0-11.png
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Bấm tổ hợp phím Ctrl + U để tải chương trình lên mạch Arduino Uno 

R3. Bạn sẽ thấy IDE xác nhận đã lập trình thành công như hình dưới. 

 

  Hình 2.5.3.13 

http://k3.arduino.vn/img/2015/05/08/0/1332_812450-1431094187-0-12.png
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2.6.Thông số kĩ thuật của LCD 1602 

Hiện giờ, thiết bị hiển thị LCD 1602 ( Liquid Crystal Display) được 

dùng trong rất nhiều các ứng dụng của vi điều khiển. LCD 1602 có rất 

nhiều ưu điểm so với các dạng hiển thị khác như: khả năng hiển thị kí tự 

đa dạng( kí tự đồ họa, chứ, số); đưa vào mạch ứng dụng theo nhiều giao 

thức giao tiếp khác nhau dễ dàng, tiêu tốn ít tài nguyên hệ thống, giá 

thành rẻ, ... 

Thông số kĩ thuật của màn hình LCD 1602: 

- Điện áp MAX: 7V 

- Điện áp MIN: -0,3v 

- Điện áp  ra mức thấp: <0.4V 

- Điện áp ra mức cao: >2.4V 

- Hoạt động ổn định: 2.7-5.5V 

- Dòng điện cấp nguồn: 350Ua- 600Ua 

- Nhiệt độ hoạt động: -30-75  độ C 

  

Hình 2.6.1. LCD 1602 xanh lá 
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Chức năng của từng chân LCD 1602: 

- Chân số 1 – VSS: chân nối đất cho LCD được nối với GND của 

mạch điều khiển 

- Chân số 2 – VDD : chân cấp nguồn cho LCD , được nối với 

VCC=5V của mạch điều khiển 

- Chân số 3 – VE: điều chỉnh độ tương phản của LCD 

- Chân số 4- RS: chân chọn thanh ghi, được nối với logic “0” hoặc 

logic “1”: 

+ Logic “0” : Bus DB0-DB7 sẽ nối với thanh ghi lệnh của LCD 

hoặc nối với bộ đếm địa chỉ của LCD 

+ Logic “1”: Bus DB0 – DB7 sẽ nói với thanh ghi dữ liệu DR bên 

trong LCD 

- Chân số 5 –R/W : chân chọn chế độ đọc/ghi, được nối với logic 

“0” để ghi hoặc nối với logic “1” đọc 

 

  Hình 2.6.2. LCD 1602 xanh dương 5V 
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- Chân số 6- E: chân cho phép (Enable). Sau khi các tín hiệu được 

đặt lên bus DB0-DB7, các lệnh chỉ được chấp nhận khi có 1 xung cho 

phép của chân này như sau: 

 + Ở chế độ ghi: dữ liệu ở bus được LCD chuyển vào thanh ghi bên 

trong khi phát hiện một xung của tính hiệu chân E 

+ Ở chế độ đọc: dữ liệu sẽ được LCD xuất ra DB0-DB7 khi phát 

hiện cạnh lên ở chân E và được LCD giữ ở bus đến khi nào chân E 

xuống mức thấp nhất. 

- Chân số 7 đến 14 – D0 đến D7: 8 đường của bus dữ liệu dùng để 

trao đổi thông tin với MPU. Có 2 chế độ sử dụng 8 đường bus này là : 

chế độ 8 bit( dữ liệu được truyền trên 4 đường từ DB4 tới DB7, bit MSB 

là DB7). 

- Chân số 15- A : nguồn dương cho đèn nền 

- Chân số 16 – K : nguồn âm cho đèn nền. 

2.7.Mạch thu âm ISD 1820 

Mạch ghi phát âm thanh ISD1820 (20s) được dùng để ghi và phát 

âm thanh được người dùng ghi vào. Đoạn ghi âm được lưu vào bộ nhớ 

của chip, dữ liệu có thể lưu trữ đến 100 năm và có thể ghi / xóa lên đến 

100.000 lần và ghi được trong tối đa 20s. 

Mạch ghi âm thanh ISD1820 dễ sử dụng, điều khiển trực tiếp bằng 

các nút nhấn trên board, hoặc có thể điều khiển thông qua các chip vi 

điều khiển như arduinom STM32, STM8, hoặc các chip xử lý khác. 

Dùng các chip để điều khiển các chức năng như thu âm, phát, hay lặp lại. 

Thông số kĩ thuật: 

- Tích hợp chức năng tiết kiệm năng lượng. 

- Các nút điều khiểu tích hợp sẵn trên board. 

- IC khuếch đại 8Ω cho loa. 
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- Nguồn nuôi 3V. 

- Có thể điều khiển thủ công hoặc bằng vi điều khiển. 

- Tần số lấy mẫu và thời gian điều chỉnh bằng điện trở. 

- Ghi âm được 20s thời gian của đoạn ghi âm. 

- Kích thước board 37 x 54mm. 

- Nếu cần thay đổi thời gian ghi âm có thể thay đổi bằng điện trở. 

- Mặc định trên bearrd hàn sẵn là 100K tương đương 10s 

 

 

Hình 2.7.1 Mạch ghi âm thanh ISD1820 
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2.8.Mạch khuếch đại âm thanh PAM8403 

Mạch khuếch đại âm thanh PAM8403 – 3W sử dụng chip khuếch 

đại lớp D cho hiệu suất cao mà không cần bổ sung tản nhiệt. 

Mạch được thiết kế nhỏ gọn giúp bạn dễ dàng lắp đặt tích hợp cho 

các loa mini hoặc tự thiết kế một loa mini với đầu đủ 2 kênh L – R với 

mỗi loa 3W( loa 4Ω ). Mạch được tích hợp bộ khuếch đại đệm có độ lợi 

cao, sử dụng tối ưu các linh kiện để cho ra hiệu suất cao nhất của một 

khuếch đại điện áp thấp. Ngoài ra mạch còn được tích hợp bảo vệ ngắn 

mạch giúp an toàn hơn khi sử dụng. 

Thông số kỹ thuật: 

- Nguồn cấp: 5VDC ( không cấp nguồn >5.5 VDC) 

- Công suất ngõ ra : 3W mỗi loa ( loa 4Ω) 

- SNR: 90dB 

- Hiệu suất: >90% 

- Kích thước: 18.5 x 15.5 x 2.8mm 

 

  

Hình 2.8.1 Mạch khuếch đại âm thanh 

PAM8403 
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Chương 3. 

THIẾT KẾ, CHẾ TẠO MÁY SÁT KHUẨN TỰ 

ĐỘNG CÓ TÍCH HỢP GIỌNG NÓI 

Cấu tạo và nguyên lí hoạt động của mạch sát khuẩn tự động: 

3.1.Cấu tạo của mạch sát khuẩn 

 

                       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                             Hình 3.1: Sơ mạch điện của máy sát khuẩn tự động 

 

Mạch điện sát khuẩn tự động bao gồm các bộ phận chính là: 

1, Nguồn mạch nguồn để chuyển đổi nguồn xoay chiều AC sang 

nguồn một chiều DC, có các dải điện áp cung cấp là +9V, +5V. Các 

nguồn này cấp cho vi xử lỷ Arduino và các mạch khác theo như Hình 

3.1 
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2, Mạch vi xử lý là mạch xử lý trung tâm, nó có nhiệm vụ xử lý 

các tín hiệu vào/ra của thiết bị, từ các tín hiệu đầu vào khác nhau 

thiết bị đưa ra những xung lệnh theo từng nhiệm vụ cụ thể.  

3. Mạch thu âm, xử lí âm thanh, được dùng để ghi và phát âm 

thanh được người dùng ghi vào 

4. Mạch khuếch đại âm thanh. 

5, Loa . 

6, Mạch LCD là mạch hiển thị các nội dung chính của quá trình 

sát khuẩn nhằm gửi đến mọi người thông tin về quá trình của thiết 

bị đang diễn ra thế nào.  

7. Cảm biến hồng ngoại, giúp xác định mục tiêu thực hiện nhiệm 

vụ máy. 

8. Động cơ bơm, giúp bơm, đẩy dung dịch rửa tay với một lượng 

nhất định, tránh lãng phí. 

9, Mạch Relay Module và động cơ bơm là mạch chấp hành khi có 

tín hiệu phát hiện ra tay người  cần sát khuẩn sẽ bơm một lượng 

dung dịch sát khuẩn vừa phải vào tay người.  

10, Các phần tử cảm biến bao gồm cảm biến hồng ngoại nhằm 

nhận biết tay người, cảm biến sóng siêu âm nhằm nhận biết có 

người đang đến gần 

11. Chip Arduino Nano- được kết nối với các bộ phận kể trên, làm 

nhiệm vụ nhận lệnh, điều khiển và thao tác hoàn toàn dựa trên 

code nhập từ IDE. 
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Bộ Code tham khảo của máy: 

#include <Wire.h>  

#include <LiquidCrystal_I2C.h> 

LiquidCrystal_I2C lcd(0x3F,16,2);  

const int trig = 5;     // chân trig của HC-SR04 

const int echo = 7;     // chân echo của HC-SR04 

const int relay = 4; 

const int sound = 6; 

const int cam_bien=3; 

int distance=0; 

int d_bk=0; 

int human=0,sat_khuan=0; 

const int thoi_gian_xa=600;  //thoi gian xa dd rua tay (mm) 

int i; 

char hand=0; 

void setup() 

{ 

lcd.init();                     

lcd.backlight(); 

Serial.begin(9600); 

pinMode(trig,OUTPUT);   // chân trig sẽ phát tín hiệu 

pinMode(echo,INPUT);    // chân echo sẽ nhận tín hiệu 

pinMode(sound,OUTPUT); 

pinMode(relay,OUTPUT); 
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pinMode(cam_bien,INPUT_PULLUP); 

} 

//------------------------- 

int do_kc() 

{ 

 unsigned long duration; // biến đo thời gian 

    int distance;           // biến lưu khoảng cách 

     

    /* Phát xung từ chân trig */ 

    digitalWrite(trig,0);   // tắt chân trig 

    delayMicroseconds(2); 

    digitalWrite(trig,1);   // phát xung từ chân trig 

    delayMicroseconds(5);   // xung có độ dài 5 microSeconds 

    digitalWrite(trig,0);   // tắt chân trig 

     

    /* Tính toán thời gian */ 

    // Đo độ rộng xung HIGH ở chân echo.  

    duration = pulseIn(echo,HIGH);   

    // Tính khoảng cách đến vật. 

    distance = int(duration/2/29.412);  

    return distance; 

} 

//----------------------------------- 

void loop() 
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{ 

           

  distance=do_kc(); 

  //xac dinh co nguoi dang tien den 

  if ((distance <150)&&(distance >30)) 

  { 

    d_bk=distance; 

    for (i=0;i<50;i++) 

    { 

    delay(100); 

    distance=do_kc(); 

    if (distance<(d_bk-10)) //tien lai gan may 

      { 

        human=1; 

        break; 

      } 

    } 

    if (i==50) 

    { 

      human=0; 

      d_bk=0; 

    } 

  } 

  if (human==1) 
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   {  

      lcd.clear(); 

      lcd.setCursor(0,0); 

      lcd.print("  XIN CHAO BAN  "); 

      digitalWrite(sound,1); 

      delay(100); 

      digitalWrite(sound,0); 

      delay(2000);  //cho noi xong 

       

   } 

   else 

   { 

    //lcd.clear(); 

    lcd.setCursor(0,0); 

    lcd.print(" MAY RUA TAY TD "); 

    lcd.setCursor(0,1); 

    lcd.print("                "); 

   }                     

    

   // 

  if (human==1)  //neu co nguoi dang tien den 

  { 

    for (i=0;i<70;i++)    //cho tien gan hon 

    { 
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    delay(100); 

    distance=do_kc(); 

    if ((distance <30) && (distance >5)) 

      { 

        break; 

        //sat_khuan=1; 

      } 

    } 

    if (i==70)  //sau 70x10ms khong tien gan hon thi quay lai che do 

cho 

      human=0; 

  } 
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3.2.Nguyên lý hoạt động của mạch điện được giải thích như 

sau: 

Khi người đến người máy sát khuẩn nó sẽ gửi lời chào “XIN 

CHÀO BẠN, BẠN HÃY RỬA TAY ĐỂ PHÒNG NGỪA COVID-19”, 

máy nhận ra người đang đến gần nhờ cảm biến siêu âm nhận biết người 

đặt ở dưới máy sát khuẩn. Sau đó người sát khuẩn tiến lại gần rồi đưa tay 

ra nó sẽ nhận biết người bằng cảm biến hồng ngoại. Tín hiệu từ cảm biến 

hồng ngoại sẽ được vi xử lý Arduino nhận biết, Vi xử lý sẽ lệnh xuống 

cho Relay đóng các tiếp điểm để cấp nguồn cho động cơ bơm. Động cơ 

bơm sẽ bơm một lượng sát khuẩn từ bình dung dịch sát khuẩn vào tay 

người, sau đó bơm dừng. Tiếp theo máy sẽ nhận diện người khác khi có 

nhu cầu sát khuẩn. 

  

Hình 1.3.2 Hình ảnh thực tế của máy. 
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KẾT LUẬN 

Sau một khoảng thời gian ngắn thực hiện đề tài tốt nghiệp, cùng với nỗ 

lực cố gắng của bản thân và sự giúp đỡ tận tình của các thầy cô giáo, bạn bè 

cùng lớp, đến nay em đã hoàn thành đề tài tốt nghiệp của mình. Trong đề 

tài của mình em đã tìm hiểu và thực hiện được các yêu cầu sau: 

- Dưới sự hướng dẫn của thầy giáo – Tiến sĩ Ngô Quang Vĩ , em đã 

có thể hoàn thành tốt được đồ án tốt nghiệp của bản thân 

- Được học hỏi, hiểu biết hơn về điều khiển không tiếp xúc, các 

mạch đơn giản mà có thể áp dụng được rất nhiều việc trong cuộc 

sống bình thường. 

- Điều tuyệt vời nhất là thấy được giá trị nhân văn sâu sắc trong 

công việc mình làm, những gì mình nghiên cứu sẽ là đóng góp to 

lớn cho xã hội. 

Một lần nữa em xin chân thành cảm ơn sự chỉ bảo ,hướng dẫn tận tình 

của thầy giáo – TS. Ngô Quang Vĩ cùng quý thầy cô trong khoa và bạn bè 

trong lớp đã giúp đỡ em trong quá trình thực hiện đề tài. 

Em xin chân thành cảm ơn! 

                                                                      

 

                                                 Hải Phòng, ngày   tháng    năm 2020 

                                                     Sinh viên thực hiện 

 

 

                                                       Nguyễn Đức Thuận 
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